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Importing a File Created by Another Word Processing Program

Word 2000 comes with filters that convert documents derived from other
sources into the Word 2000 format, allowing you to import documents from a
wide variety of sources and change them in Word 2000.

Begin by clicking File / Open.
At the bottom of the Open dialog, there is Files of type: drop-down text box.

Click on the text box down arrow and see the different file formats that Word
accommodates.

When the format of interest is selected, all files with that type extension become
visible in the Open dialog.

Other document formats are converted when the file desired is highlighted in
the Open dialog box, then opened by clicking on Open at the bottom right side
of the dialog.

Word converts the file to the Word 2000 format, then presents the document to
the user in the familiar Word program ready for use.

Hint:

Rich text files can take a long time to convert and save when working with
them in Word. Convert already existing .rtf files to Word (.doc) and work with

new documents in Word format. Only convert to rich text format as a final step.

Inserting an Existing File into the Body of the Current Document

Word can insert a whole file inside a current working document. The document
is inserted wherever the cursor is currently at. Begin by clicking on Insert / File
to open the Insert File dialog. Choose the file of interest and press the Insert
button on the bottom right of the dialog box. If you change your mind, click on
Cancel.
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Save Version

You can save multiple versions of the same document with comments
describing the differences using the Save Version button. This is useful when
you have two or more variations of the same document. Clicking the Save
Version button (found by clicking View / Toolbars / Reviewing) displays the
Save Version dialog where you can enter comments about the current version.

Use the File / Versions menu selection to view different versions of the
document. The date, time, and your comments are saved with each version so
you can distinguish one from another.

5.8 Printing and Previewing Document

In this Section you have briefly used the File / Page Setup menu selection when
you adjusted all page margins to one inch. Using the Format menu is another
way to control the appearance of your document. Review the following
information and then perform the hands-on activity.

Pages

Pages are formatted using the File / Page Setup menu selection to open the
Page Setup dialog. The Page Setup dialog includes the Margins, Paper Size,
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Paper Source, and Layout tabs from which you may adjust the appropriate
page features.

Paragraphs

The Format / Paragraph menu option brings up the Paragraphs dialog box,
which provides independent control over indents, spacing, and text flow.
Indents and spacing options control the indentation from the left and right
margins, line spacing, the indent level of the first line (paragraph indent), and
the indent level of the second and subsequent lines (hanging indent). Text flow
options control the way a selected paragraph interacts with adjacent text
elements and page breaks. For example, you can change the right and left
margins of an individual paragraph, keep the paragraph together (prevent it
from being split by a page break), change the line spacing, and set different
spacing before and after the paragraph. A typical use of a uniquely formatted
paragraph might be an embedded note. For emphasis, notes are often indented
from the left and right margins and sometimes receive additional spacing
before and/or after the text of the note.

Sections

General format settings, such as the normal margins and tab settings, are
applied to the whole document, from the current point forward, or to a section
where the document is subdivided into two or more sections. The Insert /
Break menu option is used to insert both page and section breaks. Using the
Break dialog box, you can begin a new section on the same page (click the
Continuous button) or on a new page (click the Next page button). The Break
dialog box is shown in the following illustration.

Note that you can delete both page and section breaks using the Del key. Once
you establish two or more sections within a document, you can vary the
margins, line spacing, and even the number of columns within each section
independent of the others. Therefore, when using multiple formats within a
document, be sure to insert a section for each unique format.

If you insert multiple-column text within a single-column document, the
column operation automatically creates a new section for the selected text. This
eliminates the need to insert a section break before selecting and converting a
passage to columnar text.
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Insert and Overstrike

Word is normally in the insert mode. As text is typed, following text is pushed
to the right and down. You can put word into the overstrike mode by pressing
the <Ins> or <Insert> key on the keyboard. OVR is displayed on the status bar
at the bottom of the screen when in overstrike. Press <Ins> or <Insert> again to
put Word back into the insert mode.

Cutting, Copying, and Pasting

Text is cut by selecting it and either using Edit / Cut or pressing <Ctrl+X>. This
removes the selected passage from the screen and puts it on the Windows
clipboard, from which it can be pasted. Similarly, text is copied to the clipboard
by selecting it and either using Edit / Copy or pressing <Ctrl+C>. Copied text
remains in the original position, while cut text is removed.

The clipboard is a designated portion of memory where cut or copied text or
graphics are stored. Paste is used to insert the contents of the clipboard into a
document or another Windows application. Text or a graphic image that
resides on the clipboard is inserted into a document at the cursor position by
using Edit / Paste or pressing <Ctrl+V>.

Text or a graphic image is moved or copied with these simple key sequences:

Ctrl+X Cut
Ctrl+C  Copy
Ctrl+V Paste

Delete

Delete a passage of text by selecting it and pressing <Del> or <Delete>. Delete
one character at a time by putting the cursor on the character and pressing
<Del>. You can delete words using the following sequences:

Ctrl+Del Delete next word
Ctrl+Backspace  Delete previous word
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Selecting Text

Select text by dragging it with the mouse. You can also select a word by double-
clicking it. Optionally paragraphs are selected by triple-clicking. You can select
multiple words, lines, or paragraphs by holding <Shift> while moving the
cursor with an arrow key or picking the different passages with your mouse.
Marking text is accomplished by dragging it with the mouse or by holding the
<Shift> key while pressing any key that moves the cursor including:

Home left margin

End margin
PgUp one screen up
PgDn one screen down

Ctrl+PgUp  top of screen
Ctrl+PgDn  bottom of screen
Arrow key up, down, left, or right
Ctrl+Home  top of file

Ctrl+End bottom of file
Ctrl+Right Arrow  next word
Ctrl+Left Arrow previous word
Ctrl+A entire document

Shortcut Menu

You can display a shortcut editing menu by pressing the right mouse button.

A Font...
=7 Paragraph...
= Bullets and Mumbeting. ..

_/ Draw Table

Define

You can then pick the desired operation.
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Replace All buttons—Click to replace every occurrence of the search string
without user intervention.

Finding Special Characters (Advanced Search Criteria)
You can find special characters and use wildcards with Word’s Find and

addition to these, Word features advanced search criteria used for what is often

ﬁ Replace operations using the Special button to display special characters. In

referred to as pattern matching. Check Use wildcards to take advantage of the
pattern-matching feature.

Character Description

? Wildcard for a single character; ca? finds the words cab, cad, cat, etc.; not
available in Replace.

Find a string; t*e finds the, these, those, tease, tee, etc.
[1 Find one of the specified characters; sh[ou]t finds shot or shut.

[-] Find a single character within a range; [b-e]at finds bat, cat, date, and
eat.

{n}  Find exactly n occurrences of the preceding character string; re{2}? Finds
reed and reel but not red.

{n,}  Find at least n occurrences of the preceding character string; re{1,}? Finds
reed, reel, and red.

{n,m} Find from n to m occurrences of the character or string; 3{1,4} finds 30,
300, 3000, and 30000.

@ Find one or more occurrences of the previous character or string; ho@t
finds hot and hoot.

<(beg) Find the beginning of a word; <(pre) finds words like prefix, prepare,
and previous.
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Most large documents make use of many different heading levels, just as a
Roman-style outline has levels such as:

The levels are typically used to subordinate information under different subject
headings. As you can see, Word accommodates this need by providing users
with built-in heading styles named Heading 1, Heading 2, and so on.

The Importance of Styles

Styles are applied by placing the cursor on a heading or passage of text and

then selecting the desired style name from the Formatting toolbar’s Style
dialog.

EE

iDefault Paragraph Font

‘Heading 1

Heading 2

Heading 3
Klormal

You can create styles of your own and add them. Just format a selection,
highlight it, click on the style box, and type a descriptive style name. This can
be saved to the global normal. dot template using the Format / Style menu
selection and corresponding dialogs. It’s just as easy to change existing styles.
For example, many users find the default 10-point font size is too small and

change it to 12 points. You can also change the heading styles to suit your
personal taste.

Applying heading styles is extremely important if you plan to use the Master
Document and Outline views (see the View menu). The use of heading styles is
also required when generating an automatic table of contents or table of figures

(see Insert / Index and Tables), as Word relies on the style levels for format
control.
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Use the Format button to modify the font, size, paragraph settings, borders, and
more using corresponding dialogs. If you wish, you can use the Shortcut Key
button to assign a shortcut key sequence to your new style. You can also use the
Modify button to assign a shortcut key sequence to existing styles. This is
intended as a time saver and is optional.

5. Once the format is set to your liking, click OK and check the format
information in the Description area.

6. When finished, click the Apply button to save the style with the current
document or click Close to avoid saving the style.

Style Creations Shortcut

You can also create a new style by selecting a paragraph containing the style
parameters you want. Then:

1.  Pick the Style box (left edge of the Format toolbar) with your mouse.
2. Type a meaningful style name.

3.  Press <Enter> to finish adding the new style to your list.

Deleting a Style

Delete an unwanted style using the Format / Style selection. Just pick the style
name in the Style dialog Styles list and click the Delete button. Finally, click
Close to exit the dialog.

Copying Styles to Other Documents

You can use the Style dialog box to copy a new style to a template file. For
example, you may want to put a Note title style in the Normal.dot template.
Begin by opening the document in which the new style is available. Then open
the Style dialog. Note that you can change the List setting to pick styles from
different sources. When set, click the Organizer button to display the Organizer
dialog box.
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Modify Style
Name:

[Biormal i=b)] Batagranh -]

Based on: Stvle for following paragraph:
I 9 tormal _{] r 91 Mormal (*Webj LI

Preview

Saspis Tertamgic Textumple TorSaaple Textample Textample TexSasgic
Tertaspie TerSasple TemCuaple Tertadpls TexCadpls TextSample Teatasgle
TexSaspic TexSiaple TextSasple TentSasple TemSaspls TenSampls TexcSdayle
Textlasyds Terasyle Ter

Description
Mormal + Font: ‘12 pt, Space before 5 pt after 5 pt

I Add to template [~ automatically update

I OK I Cancel | Format ~ Shortcut Key... l

Pick the desired style name and click Copy to copy the style from the selected
source document to the template. As you can see from the preceding dialog box
illustration, you can also delete and rename styles here as well. Rename is often
used to make a style name more descriptive or to eliminate conflicting names.

Fonts

Available fonts depend on the installed printer and Windows applications. If
you are using Windows 95/98 with Microsoft TrueType fonts, you have a nice
starter set. You can also install additional fonts by purchasing available font
packs. Some applications, such as Microsoft Publisher and Corel Draw, add
many new fonts to Windows. If you have a PostScript printer, you may have
several built-in printer fonts. Regardless of the installed printer, a type style
usually requires several fonts to round out an entire font family. For example,
you may have a normal, bold, and italic font. Therefore, Times New Roman
normal, bold, and italic count as three fonts.

Fonts are changed by picking the font box and then pressing the Down Arrow
to view a list of font names. Then pick the desired font name. You can type the
first letter of a font, such as C, to move to the beginning of those fonts that start
with the letter C. To change the font in an existing passage, simply highlight it
and pick a new font name.
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Font Sizes

L! Z Font sizes are increased or decreased using the Font Size box on the Formatting
toolbar. The down arrow displays different numbers that correspond to point
sizes (a point is 1/72 of an inch). You can pick a new size from the displayed

list. You can also:

Diganzer B3|

Styles ] AutoText ] Toolbars ] Macro Project Items l
In Lec 6.doc: To Mormal.dot:

Copy M l Default Paragraph Font =]
= Heading 4

Delete I Heading 9

— Mormal

Rename...

Body Text Indent 3

bullet =l |
Styles available in: Styles available in:
lLec 6.doc (Document) _:l lNormal.dot (global template) _'I

Close File Close File I
Description

Mormal + Font: Times Mew Roman, 11 pt, Not Bold, Indent: Left 0.5" Justified, Line spacing at least
14 pt

e Increase the font size of a selected passage one point at a time with <Ctrl+]>.

e Decrease the font size of a selected passage one point at a time with

<Ctrl+[>.

Type Styles (or "Attributes”)

Type attributes include normal, bold, italic, and underline. The default attribute
setting is normal. You can change the attribute of existing text by selecting it (so
that it is highlighted) and then clicking the B, I, or U button on the formatting
toolbar. If you are a keyboard person, you can also use one of the following key
sequences to achieve the same result:

Ctrl+B  Boldface
Ctrl+I  Italic
Ctrl+U Underline
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To enter new text in the desired attribute, select the attribute button or key
sequence and type the text. Click the button again or press the key sequence to
turn off the attribute.

Changing Case

Word offers you a quick way to change uppercase to lowercase and initial
capitals (first letter capitalized). To change case, select a passage of text and use
the Format / Change Case menu selection to use the Change Case dialog. Or
press <Shift+F3>. The first keypress changes the passage from all lowercase to
an initial capital followed by lowercase. The second keypress changes it to all
capitals. Pressing <Shift+F3> again changes the selection back to all lowercase.

Hands-on Activity

In this activity you use the Sample2.doc file with the Font Style, Font, and Font
Size commands described above.

1. Start Word and open Some Sample Document.

2. Use the File / Page Setup menu selection to set all margins to 1" and click
OK.

3. Press <Ctrl+A> to select all. Then click the Font Size down arrow on the
Formatting toolbar and pick 12 points.

4. Put the cursor on the first paragraph. Pick the Style box, type Norm12, and
press Enter.

5. Notice that Norm12 is displayed in the Style box at the left end of the
Format toolbar.

Note: The Norm12 style is now attached to the Sample2.doc. If saved, it can be
copied to the global Normal.dot template using the Format / Style menu
selection’s Organizer dialog.

6. Highlight the entire first paragraph of the document.

7. Click the Arial font (or another available font) on the Formatting toolbar.
Notice how the paragraph changes.
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8. With the passage still selected, pick 8 from the Font Size list. Notice how the
font size of the selected passage changes.

9. Select the centered Sample2.doc title at the top of the first page, and press
<Shift+F3> to change the case from uppercase to lowercase to initial
capitals and then to uppercase again.

10. Exit Word with <Alt+F4> and pick the No button to avoid saving the
changes.

6.5 Creating Lists and Numbering headings

Word makes list creation and conversion simple. You can convert lines of text
= into numbered lists or procedural steps. Word automatically assigns the proper
(-‘ b numeric sequence to a series of selected passages. Similarly, Word lets you
select one or more paragraphs (or lines) of text and then convert the selected
passage into a bulleted list. The Format / Bullets and Numbering menu
selection lets you modify the bullet style or the numbering sequence.

Bullets and Numbering 2[x]|

ed’ ] Mumbered I ‘Outline Mumbered I

= ¢ °

None k= ¢ °

= L 4 L
® & c2g =
* 8 = =
b1 ] = =

| OK I Cancel |

The fastest way to create a numbered or bulleted list is to use the Numbering or
Bullets buttons on the Format toolbar. Once text is selected, simply click the
appropriate button to automatically convert your list to the desired form.
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Heading Numbering

When you use different heading styles from the style box, i.e., Heading 1,
Heading 2, etc., you can apply heading numbers using the Outline Numbered
tab of the Bullets and Numbering dialog. Here, multilevel outlines and

indentations are automatically applied. Just pick the style you want to use and
click OK.

Tip: Styles are created, changed, and applied from the Style box on the
Formatting toolbar. Just click on the text element and then choose the desired
style.

8. Press <Alt0+F4> and click No to exit Word without saving your changes to
the Sample2.doc file.

6.6 Creating Headers and Footers
A header is a text that appears at the top of each page (or the pages you select,
such as all Even pages) in your document. Footer appears at the bottom of your
pages. You don't have to add headers and footers to each page - Word 2000

enables you to type them just once and it automatically add them to each page.

A Header contains text that appears at the top of your document pages.
Footer contains text that appears at the bottom of your document pages.

To add a header or footer, follow these steps:

o Select View, Header and Footer to display the Header and Footer toolbar, as
well as outline boxes where you can type the header and footer text.

e Type your header text. If you want to type footer text, click the toolbars
switch between Header and Footer button to display the footer text box and
type your footer text, click the appropriate toolbar buttons.

e Click the Close button to anchor the header or footer in your document.

Word 2000 normally dims header and footer text so that you can easily
distinguish between the header, footer, and the rest of your document text
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6.7 Inserting Page Breaks, Page Numbers, Bookmarks, Symbols

and Dates

The Insert Menu

The Insert menu, shown here, includes a number of selections. Once you know
its uses, a substantial amount of power is placed at your fingertips.

This section deals with a few of the Insert menu’s capabilities. Following
sections address the remainder of the menu items. Below is a list of what each
of the menu selections does. Then a hands-on activity guides you through the
use of several of these.

Break —Inserts a page break, column break, or section breaks at the current
cursor position.

Page Numbers—Inserts a page number and controls the format, position, and
value.

Date and Time —Inserts the current date and/or time. Pick the format from a
list.

Insert Format Tools Table
Break...
Rage Mumbers...
Date and Time...
AutoText L4
Field...
Symbol. .,

|_El Comment

Footnote...
Caption...
Cross-reference. .,
Index and Tables...

Picture 14
A
=] Text Box

File. .

Object...

Baokmark...

%Hyperﬁ_nk. . Chrl4k
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Inserting New Columns and Rows

Not creating enough rows or columns for your table is one of the first table
problems you will encounter. To insert or delete rows or columns, select a row
or column and right click your mouse.

Suppose that you need to insert a column. Select the column that will appear
after the new column by pointing above the column until the mouse pointer
changes to a down arrow. Select multiple columns by dragging your mouse to
the right after you have selected one column. Right-click your mouse to mouse
to display a pop-up menu. The menu will be different depending on whether
you have selected a row or column first. Select Insert Columns, and Word 2000

inserts a new column before the selected columns command.

To highlight a row, point to the margin left of the row; Word 2000 highlights
the entire row. Drag your mouse down or up to select multiple rows. When you
right-click your mouse, the pop-up menu contains an Insert rows and a Delete
Rows command.

7.7 Short Summary

% A Comment is Word 2000 document message that you can see onscreen
but that does not print.

& Tables are collections of information organized in rows and columns.
Tables might contain numbers, text, even graphics, or combinations of any
of these.

&% A cell is a single table entry.
&  WordArt offers many powerful features for emphasizing your written

communications with special sizing, stretching, rotation, font selection,
shading, and more.
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Excel 2000 can work with the following kinds of data:

e Labels: Text values such as names and addresses.

e Numbers: Numeric values such as 34, -291, 545.67874, and 0

e Formulas. Expressions that compute numeric results (some formulas work
with text values as well)

e Special formats: Date and time values

Entering Text

If you want to put text (such as a title or a name) in a cell, just place your cursor
in the cell and type the text. Excel 2000 left-justifies the text in the cell. As you
type, the text appears both in the cell and in the Formula bar. Remember that
the Name box to the left of the Formula bar displays the name of the cell into
which you are entering data. When you press Enter, Excel 2000 moves the cell
pointer down one row.

If you press Esc at any point during your text entry, Excel 2000 erases the text
you typed in the cell and restore the original cell contains.

If your text is wider than the cell, Excel 2000 does one of the two things
depending on the contents of the adjacent cell to the right:

o If the adjacent cell is empty , Excel 2000 erases the text you typed in the cell
and restores the original cell contains

e If the adjacent cell contains data, Excel 2000 truncates (cuts off) the wide cell
to show only as much text as fits in the cell’s width. Excel 2000 does not

remove the unseen data from the cell: however, the adjacent cell, if that cell

contains data, always displays instead.
Note:

A label is text data inside an Excel 2000 cell
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Entering Numbers

Excel 2000 accepts numeric values of all kinds. You can type positive numbers,
negative numbers, numbers with decimal points, zero-leading numbers, numbers with
dollar signs, percent signs, and even scientific notation (a shortcut for writing
extremely large and small numbers) Excel 2000 right-justifies numbers inside cells.
You can change the format for a single cell or for the entire worksheet.

Entering Dates and Times

Excel 2000 supports almost every national and international date and time format.
Excel 2000 uses its AutoFormat feature to convert any date or time value that you
type to a special internal number that represents the number of days since midnight,
January 1,1900. As with all Office 2000 products, Excel 2000 is Y2K —complaint
meaning that Excel 2000 automatically displays all dates the user enters with four-
digit year values by showing the full year. Excel 2000 should have little problem with
the millennium change. Although this strange internal representation might not make
sense now, you use these values a lot to compute time between two or more dates.

Using Formulas

Without formulas, Excel 2000 would be little more than a word processor for tables of
information. When you use formulas, however, Excel 2000 becomes an extremely
powerful time saving planning, budgeting, and general-purpose financial tool.

A Formula is a calculation that produces a result. Formulas can include math
operators, numbers, cell addresses, and range names.

9.4 Auto fill

Nothing is more tedious than entering a long sequence of numbers or dates in a
column. So let Excel handle the drudge work. As the name implies, its AutoFill
feature can automatically fill in information as you drag the mouse through a
range. You can use AutoFill to enter the days of the week, months of the year,
any series of numbers or dates, and even custom lists that you create.

Before you can use AutoFill, however, you need to learn to reorganize Excel’s fill
handle. Select any cell or range, and you will see a thick border around the selection.
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Entering Numbers

Excel 2000 accepts numeric values of all kinds. You can type positive numbers,
negative numbers, numbers with decimal points, zero-leading numbers, numbers with
dollar signs, percent signs, and even scientific notation (a shortcut for writing
extremely large and small numbers) Excel 2000 right-justifies numbers inside cells.
You can change the format for a single cell or for the entire worksheet.

Entering Dates and Times

Excel 2000 supports almost every national and international date and time format.
Excel 2000 uses its AutoFormat feature to convert any date or time value that you
type to a special internal number that represents the number of days since midnight,
January 1,1900. As with all Office 2000 products, Excel 2000 is Y2K —complaint
meaning that Excel 2000 automatically displays all dates the user enters with four-
digit year values by showing the full year. Excel 2000 should have little problem with
the millennium change. Although this strange internal representation might not make
sense now, you use these values a lot to compute time between two or more dates.

Using Formulas

Without formulas, Excel 2000 would be little more than a word processor for tables of
information. When you use formulas, however, Excel 2000 becomes an extremely
powerful time saving planning, budgeting, and general-purpose financial tool.

A Formula is a calculation that produces a result. Formulas can include math
operators, numbers, cell addresses, and range names.

9.4 Auto fill

Nothing is more tedious than entering a long sequence of numbers or dates in a
column. So let Excel handle the drudge work. As the name implies, its AutoFill
feature can automatically fill in information as you drag the mouse through a
range. You can use AutoFill to enter the days of the week, months of the year,
any series of numbers or dates, and even custom lists that you create.

Before you can use AutoFill, however, you need to learn to reorganize Excel’s fill
handle. Select any cell or range, and you will see a thick border around the selection.
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